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ABOUT THIS MANUAL

Read the following information before using the service manual.

What you can do with this manual

Search for a Ref. No. (phrase)
(Ctrl+Shift+F)

You can use the search function in Acrobat Reader to
search for a Ref. No. in schematic diagrams, printed
wiring board diagrams, block diagrams, and parts
lists.

1.Press Ctrl+Shift+F on the keyboard.
e The Search window appears.

2.Enter the Ref. No. you want to search for in the
Search window, and then click the Search button.
«A list of search results appears.
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3.Click an item on the list.
* The screen jumps to the page for that item, and the
search phrase is displayed.

Jump to the target of a schematic
diagram connector

Click the Ref. No. of the target connector in the red
box around a schematic diagram connector.
*The screen jumps to the target connector.
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*Page magnification stays the same as before the
jump.




Using Adobe Reader (Windows version)

Add notes to this data (Sign)

The Sign function lets you add notes to the data in
this manual.
Save the file once you have finished adding notes.

[Example using Adobe Reader X]
On the "View" menu, click "Sign".

Magnify schematic / printed wiring
board diagrams - 1

(Ctrl+Space, mouse operation)

Press Ctrl+Space on the keyboard and drag the
mouse to select the area you want to view.
* The selected area is magnified.

¢ The Sign pane appears.
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*  When you want to move the area shown, hold
down Space and drag the mouse.

[Example using Adobe Reader 9]

On the "Document” menu, click "Sign". *  When you want to show a full page view, press

Ctrl+0 on the keyboard.

Print a magnified part of the manual

The Properties dialog box and functions will vary depending on your printer.
1. Drag the mouse to magnify the part you want to print.

2. On the "File" menu, click "Print".

3. Configure the following settings in the Print dialog box.

«_Properties
Click this button and check that the printer is set to a
suitable paper size.

¢ _Paqge to print

; ]
e NFrew | e | Dre | Select the following checkbox.
o "More Options" : "Current View"
ey ¢ _Page Sizing & Handling
9::;:'”* Select the following checkbox.
T = ) "Size" / "Size Options" : "Fit"
\_
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4. Click the Print button to start printing.




Magnify schematic / printed wiring
board diagrams - 2

(Pan & Zoom function)

The Pan & Zoom function lets you see which part of
a magnified diagram is being shown in a separate
window.

[Example using Adobe Reader X]
On the "View" menu, point to *Zoom", and then click
"Pan & Zoom".
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[Example using Adobe Reader 9]
On the "Tools" menu, point to "Select & Zoom", and
then click "Pan & Zoom Window".

Magnify schematic / printed wiring
board diagrams - 3
(Loupe Tool function)

The Loupe Tool function lets you magnify a specific
part of a diagram in a separate window.

[Example using Adobe Reader X]
On the "View" menu, point to "Zoom", and then click
"Loupe Tool".
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[Example using Adobe Reader 9]
On the "Tools" menu, point to "Select & Zoom", and
then click "Loupe Tool Window".




SAFETY PRECAUTIONS

leakage current check

power cord is less than 460 kohms, the set is defective.

(on, off and standby mode), if applicable.

The following items should be checked for continued protection of the customer and the service technician.

Before returning the set to the customer, be sure to carry out either (1) a leakage current check or (2) a line to chassis
resistance check. If the leakage current exceeds 0.5 milliamps, or if the resistance from chassis to either side of the

Be sure to test for leakage current with the AC plug in both polarities, in addition, when the set's power is in each state

CAUTION | Please heed the following cautions and instructions during servicing and

inspection.

O Heed the cautions!

Cautions which are delicate in particular for servicing

are labeled on the cabinets, the parts and the chassis,

etc. Be sure to heed these cautions and the cautions

described in the handling instructions.
© Cautions concerning electric shock!

(1) An AC voltage is impressed on this set, so if you
touch internal metal parts when the set is energized,
you may get an electric shock. Avoid getting an
electric shock, by using an isolating transformer
and wearing gloves when servicing while the set is
energized, or by unplugging the power cord when
replacing parts, for example.

(2) There are high voltage parts inside. Handle with
extra care when the set is energized.

© Caution concerning disassembly and
assembly!

Through great care is taken when parts were

manufactured from sheet metal, there may be burrs on

the edges of parts. The burrs could cause injury if fingers
are moved across them in some rare cases. Wear gloves
to protect your hands.

O Use only designated parts!

The set's parts have specific safety properties (fire

resistance, voltage resistance, etc.). Be sure to use parts

which have the same properties for replacement. The
burrs have the same properties. In particular, for the
important safety parts that are indicated by the /\ mark
on schematic diagrams and patrts lists, be sure to use
the designated parts.
O Be sure to mount parts and arrange the wires
as they were originally placed!

For safety seasons, some parts use tapes, tubes or other

insulating materials, and some parts are mounted away

from the surface of printed circuit boards. Care is also
taken with the positions of the wires by arranging them
and using clamps to keep them away from heating and
high voltage parts, so be sure to set everything back as
it was originally placed.

O Make a safety check after servicing!
Check that all screws, parts and wires removed or
disconnected when servicing have been put back in their
original positions, check that no serviced parts have
deteriorate the area around. Then make an insulation
check on the external metal connectors and between
the blades of the power plug, and otherwise check that
safety is ensured.
(Insulation check procedure)
Unplug the power cord from the power outlet, disconnect
the antenna, plugs, etc., and on the power. Using a 500V
insulation resistance tester, check that the insulation
resistance value between the inplug and the externally
exposed metal parts (antenna terminal, headphones
terminal, input terminal, etc.) is 1TMQ or greater. If it is
less, the set must be inspected and repaired.

CAUTION | Concerning important

safety parts

Many of the electric and the structural parts used in the
set have special safety properties. In most cases these
properties are difficult to distinguish by sight, and the use
of replacement parts with higher ratings (rated power
and withstand voltage) does not necessarily guarantee
that safety performance will be preserved. Parts with
safety properties are indicated as shown below on the
wiring diagrams and the parts list in this service manual.
Be sure to replace them with the parts which have the
designated part number.

(1) Schematic diagrams....... Indicated by the A\ mark.
(2) Partslists....... Indicated by the /\ mark.
The use of parts other than the
designated parts could cause electric
shocks, fires or other dangerous
situations.



NOTE FOR SCHEMATIC DIAGRAM

WARNING:

Parts indicated by the /\ mark have critical characteristics. Use ONLY replacement parts recommended by the manufacturer.

CAUTION:

Before returning the set to the customer, be sure to carry out either (1) a leakage current check or (2) a line to chassis resistance check. If
the leakage current exceeds 0.5 milliamps, or if the resistance from chassis to either side of the power cord is less than 460 kohms, the set
is defective.

WARNING:

DO NOT return the set to the customer unless the problem is identified and remedied.

NOTICE:

ALL RESISTANCE VALUES IN OHM. k=1,000 OHM / M=1,000,000 OHM

ALL CAPACITANCE VALUES ARE EXPRESSED IN MICRO FARAD, UNLESS OTHERWISE INDICATED. P INDICATES MICRO-MICRO
FARAD. EACH VOLTAGE AND CURRENT ARE MEASURED AT NO SIGNAL INPUT CONDITION. CIRCUIT AND PARTS ARE SUBJECT
TO CHANGE WITHOUT PRIOR NOTICE.

NOTE FOR PARTS LIST

. Parts indicated by "nsp" on this table cannot be supplied.
. When ordering a part, make a clear distinction between "1" and "I" (i) to avoid mis-supplying.

. A part ordered without specifying its part number can not be supplied.
. Partindicated by "s" mark is not illustrated in the exploded view.
. General-purpose Carbon Film Resistor in the P.W.Board parts list. (Refer to the Schematic Diagram for those parts.)

. General-purpose Carbon Chip Resistors are not included are not included in the P.W.Board parts list.
(Refer to the Schematic Diagram for those parts.)
WARNING: Parts indicated by the /A\ mark have critical characteristics. Use ONLY replacement parts recommended by the manufacturer.

o 0~ WN P

INSTRUCTIONS FOR HANDLING SEMI-CONDUCTORS AND OPTICAL UNIT

Electrostatic breakdown of the semi-conductors or optical pickup may occur due to a potential difference caused by
electrostatic charge during unpacking or repair work.

1. Ground for Human Body

Be sure to wear a grounding band (1 MQ) that is properly grounded to remove any static electricity that may be
charged on the body.

2. Ground for Workbench

Be sure to place a conductive sheet or copper plate with proper grounding (1 MQ) on the workbench or other surface,
where the semi-conductors are to be placed. Because the static electricity charge on clothing will not escape through
the body grounding band, be careful to avoid contacting semi-conductors with your clothing

<Incorrect> <Correct> Grounding Band

/

1MQ

Conductive Sheet or
Copper Plate




Personal notes:




TECHNICAL SPECIFICATIONS

11 Power amplifier section 1 Overall performance
¢ Rated Output Power: ¢ S/N Ratio (A network):
both channels driven (CD IN—- SPEAKER OUT) PHONO (MM): 89 dB
70 W + 70 W (8 Q/ohms, 20 Hz — 20 kHz, T.H.D. 0.07 %) (With input terminals short-circuited, 5 mV input signal)
« Dynamic power: PHONO (MC): 74 dB o ) )
140 W + 140 W (4 Q/ohms, DIN, 1 kHz, T.H.D. 0.7 %) %f'}ﬁ,ﬁ“éé%;ﬁ'a;'}wgg&?"sgb%ig‘g’é?qggsg%‘a')
¢ High frequency distortion: (input terminals short-circuited)
0.01 % (Rated output: -3 dB), 8 Q/ohms, 1 kHz ¢ Tone control :
o Qutput terminals: BASS: 100 Hz +8 dB
Speaker: TREBLE: 10 kHz 8 dB
AorB: 4 - 16 Q/ohms 1 General
A+B: 8 16 Qjohms Power supply (for E2 model) : AC 230 V, 50/60 Hz

Suited for headphones/stereo headphones
° |Ilp|.lt Sensitivity/ |llpl.lt Impedance: Power Sllpply (fﬂr E1C model) :AC 220 V, 50 Hz

P. DIRECT: 0.84 V / 47 kQ/kohms Power supply (for JP model) : AC 100 V, 50/60 Hz
Gain: 29 dB Power consumption : 295 W

(1 Pre amplifier section Power consumption during standby : 0.2 W

o Equalizer amplifier output: (REC OUT terminals)
150 mV

¢ Input Sensitivity/Input Impedance:

PHONO (MM):2.5 mV/47 kQ/kohms

PHONO (MC): 200 uV/100 Q/ohms

CD, TUNER, AUX, NETWORK, RECORDER:
125 mV/47 kQ/kohms (SOURCE DIRECT: Off)
125 mV/23 kQ/kohms (SOURCE DIRECT: On)

¢ RIAA Deviation:
PHONO: 20 Hz — 20 kHz +0.5 dB
e Maximum Input:

PHONO (MM):130 mV/1 kHz
PHONO (MCJ:10 mV/1 kHz

¢ Rated Output:
PRE OUT: 0.84 V (Input CD 125 mV)

DIMENSION

Unit : in. (mm)
Weight : 16.1 kg
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DISASSEMBLY

» Disassemble in order of the arrow in the following figure.
* Inthe case of the re-assembling, assemble it in order of the reverse of the following flow.
* Inthe case of the re-assembling, observe "attention of assembling”.
» If wire bundles are untied or moved to perform adjustment or replace parts etc., be sure to rearrange them neatly as
they were originally bundled or placed afterward.
Otherwise, incorrect arrangement can be a cause of noise generation.

TOP COVER

Y

\

Y

FRONT PANEL ASSY

Refer to "DISASSEMBLY
1.FRONT PANEL ASSY"
and "EXPLODED VIEW"

POWER SW.UNIT

FRONT SW UNIT

VOLUME UNIT

POWER LED UNIT

VOL SUB UNIT 1

VOL SUB UNIT 2

H/P UNIT

FUNCTION SW UNIT

REMOTE IN/OUT UNIT

TONE UNIT

(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :
(Ref. No. of EXPLODED VIEW :

(Ref. No. of EXPLODED VIEW :

1-3)
1-4)
1-5)
1-6)
1-7)
1-8)
1-9)
2-3)
2-4)

2-5)

POWER AMP PWB
Refer to "DISASSEMBLY
2. POWER AMP PWB"
and "EXPLODED VIEW"
POWER AMP UNIT
(Ref. No. of EXPLODED VIEW : 1-1)

INPUT PWB
Refer to "DISASSEMBLY
3. INPUT PWB"
and "EXPLODED VIEW"
INPUT UNIT
(Ref. No. of EXPLODED VIEW : 2-2)

\

\

REC INPUT PWB
Refer to "DISASSEMBLY
5. REC INPUT UNIT"
and "EXPLODED VIEW"
REC INPUT UNIT
(Ref. No. of EXPLODED VIEW : 1-10)

U-COM PWB
Refer to "DISASSEMBLY
4. U-COM PWB"
and "EXPLODED VIEW"
U-COM UNIT
(Ref. No. of EXPLODED VIEW : 2-1)

\

y

POWER TRANS
Refer to "DISASSEMBLY
6. POWER TRANS"
and "EXPLODED VIEW"
POWER TRANS
(Ref. No. of EXPLODED VIEW : 37)

AC UNIT
Refer to "DISASSEMBLY
and "EXPLODED VIEW"
AC UNIT
(Ref. No. of EXPLODED VIEW : 1-2)

10




About the photos used for "descriptions of the DISASSEMBLY" section

The shooting direction of each photograph used herein is indicated on the left side of the respective photograph as
"Shooting direction: ***".

» Refer to the diagram below about the shooting direction of each photograph.

*  Photographs with no shooting direction indicated were taken from the top of the set.

The viewpoint of each photograph Shooting direction: B
(Shooting direction X) \]/

[View from the top] _
Front side

)

Shooting direction: C—> <— Shooting direction: D

Shootingj?rection: A
1. FRONT PANEL ASSY

Proceeding: | TOP COVER |—| FRONT PANEL ASSY |

(1) Remove the screws.

iew from the bottom

-

v e o0
N0822 N051 w

(3) < Attention of assembling >
Fix the wiring of the wire like this photograph.

Please refer to "EXPLODED VIEW" for the disassembly method of each PWB included in FRONT PANEL ASSY.

11



2. POWER AMP PWB

Proceeding : | TOP COVER |—|POWER AMP PWB]

(1) Cut the wire clamp bands, then disconnect the connector wires. Remove the CORD HOLDER and screws.

3. INPUT PWB

Proceeding: | TOP COVER |—| INPUTPWB |

(1) Disconnect the connector wires. Remove the PCB HOLDER and screws.

12



4. U-COM PWB

Proceeding: | TOP COVER |—| INPUTPWB |—| U-COMPWB |

(1) Disconnect the connector wires. Remove the PCB HOLDER.

|3
[ t - ¥ .
=

; 4 A .\'.": II.-Z." 2 3.\ 7 - .
821 - U= PCB HOLDER

5. REC INPUT PWB

Proceeding : | TOP COVER |—| REC INPUT PWB |

(1) Remove the screw.

6. TRANS

Proceeding: | TOP COVER |—| TRANS |

(1) Cut the wire clami) bands, then disconnect the connector wires. ;Bemve the CORD HOLDER and screws.

| F s
Y (@ @) |
e — ™ -ll.ﬁ

CORD HOLDER

13



ADJUSTMENT
IDLING CURRENT ALIGNMENT

4 4 A

DC Voltmeter

0.008 v

DO

@lﬁ@
_

o]
o
[y
=z
(o]
o
N

)
o)
©
ol
)
[o5)
©
(o2}

Trans
] — N
Trans
8U-110144-1

Power Amp P.W.B.

L |

Volume
Setup

(1) Place the unit at an ordinary position avoiding direct air flow from an air-conditioner or fan. Do the adjustment at a
temperature between 15°C (59°F) and 30°C (86°F).

(2) Set control as follows.
POWER switch — OFF (m).
VOLUME comtrol ~ — Fully counterclockwise () min).
SPEAKER terminals — Open: do not connect the speakers.

Adjustment

(1) Remove top cover. And then connect DC voltmeter to the test points N801 and N802 of POWER AMP P.W.B.
(8U-110144-1).

(2) Connect power cord to AC230V (218~242V) (Europe & Asia models) or (AC220V (209~231V) (China models) wall
outlet, and turn POWER switch "ON" ().

(3) Right after power on, adjust R895 and R896 so that the DC voltmeter reads 10 £ 2mV.

(4) Then after 2 minutes warmup adjust R895 and R896 so that the DC voltmeter reads 10 + 1mV.

(5) And after 10 minutes warmup adjust R895 and R896 so that the DC voltmeter reads 10 £ 1TmV.

14



TROUBLE SHOOTING

1. The power can not be turned on. (Power indication LED does not light.)

Check the insertion of the
8U-110144-2 AC UNIT .

v

Check the insertion of the
8U-110145-1 p-com UNIT.

v

Check whether power is

being supplied to the coil Power not supplied.

of the standby transformer

Broken wire in standby
transformer (T101).

(T101).

Power supplied.

>

Check whether power
is being supplied to
the D101-106.

Power not supplied.

Malfunction of
D101-106.

Power supplied.

Malfunction of
U301, U303.

2. The power turned on, but a sound does not output normally. (Both channels)

2.1 Set remains in standby mode.

Check each connector. |

v

Check whether power
is being supplied to the
FUSE F-101.

Power not supplied.

P Broken FUSE F-101.

Power supplied.

Check whether power
> is being supplied to
the coil of the main
transformer.

Power not supplied.

Broken wire in main
transformer.

Power supplied.

Malfunction of U301,
D313, Q318, S102.

2.2 Power indicator LED remains flashing red and muting mode is not canceled

(protection mode is set).
Flashes in cycles of 0.5 seconds

Check the flashes
cycle of the red LED.

0.25 seconds lit, 0.25 seconds off)>

Damaged power amplifier circuit

Flashes in cycles of 2 seconds

(1 second lit, 1 second off)

>

Damaged temperature detection circuit.

2.3 Set operates, but then power indicator LED flashes red (protection mode is set).

Flashes in cycles of 0.5 seconds

Damaged power
amplifier circuit

Check the flashes 0.25 seconds lit, 0.25 seconds off) >
cycle of the red LED.

Flashes in cycles of 2 seconds

(1 second lit, 1 second off) >

Switch off power at
once, and re-apply
the power after the
body temperature

has fallen sufficiently.

Green LED lit

>

No problems.

For proper heat dispersal,
do not install this unitin a
confined space.

15

Red LED flashes.

Damaged temperature
detection circuit.




Personal notes:
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LEVEL DIAGRAM

EQ : """""""""""""""
e h : """"""" j ]
- Ji H {H/P
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(MM/MC)
35.6dB(MM)
@ 01§ N ———
57.6dB(MC) =i ® ! SPEAKER A |
0 C";/O ] AN i
(O] [—
! SPEAKER B |
TUNER Qe oo —8 SN @ e i
DIRECT 7J (Bi-Wiring)
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RECORDER | ( (» D~ 0or—=8 R —¢ g”
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POWER DIAGRAM

YTy | STANDBY |
iPOWER SW | o~0 | | “1RANS i
I | +oV : _ +3.3V (¢t —com STANDBY)  _
R %“% <* Y “| U301 TMP86FH47BUG ( it —com)
I o1 o D_GND | U302 LB1930MC (motor driver)
o 4% U205 NJU7181(Signal detection IC)
. |B assist U206 NJU7181(Signal detection IC)
Main RL 2200/35 D519 (Power LED RED)
» o 14V o ov e » +5V | D513-8 (Function LED)
+ 7

S801 SP Relay

FUNCTION SWITCHING IC

+12V - S802 Pre out Relay
“| S803 H/P Relay
| & . D_GND | S201/202/603 signal Relay
%u “| (Power LED Green) D519
% +50V -
P i A_GND = POWER AMP BLOCK
g Current amplification stage
-50V -50V -
8200/71 +16V, o+1 6V _
+ >
VAN VOLTAGE o |AGND , | POWERAMPBLOCK
i---[-R-e\-l\J-S--*-z---: REGULATOR ¥ > oltage amplitication stage
o -16V >
-16V
@ >
® > TONE UNIT OP-AMP
< | >
& >
| > PHONO OP-AMP
& >
@ >
» Signal detection OP-AMP
@ >
> REC OUT BUFFER OP-AMP
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WIRING DIAGRAM
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Lead-free Solder
When soldering, use the Lead-free Solder (Sn-Ag-Cu).
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EXPLODED VIEW

Please refer to the last chapter for the part list.

WARNING:
Parts marked with this symbol A\ have critical characteristics.
Use ONLY replacement parts recommended by the manufacturer.
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Personal notes: Personal notes:
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PACKING VIEW

Please refer to the last chapter for the part list. A
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SEMICONDUCTORS

Only major semiconductors are shown, general semiconductors etc. are omitted to list.
The semiconductor which described a detailed drawing in a schematic diagram are omitted to list.

1
1. IC's
TMP86FH47BUG (8U-110145 : U301)
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TMP86FH47BUG Block Diagram

High—freguency clock CPU (TLCS-27 0420
oscillator
A W A
Low—frequency clock Bz 5 o
oscillator oE o e
HL H L
Timing Genarator - ”
il v
5P 5P
Standby Controller
- 15 Ht -
Interrupt Controller
Time Base Timer
BOOTROM(2048Bytes)
PO RAM{512Bytes)
F1 FLASH(16384Bytes)
F2 Watch Dog Timer
P3
P4

30

10-bit AD Gonverter(8ch)

HEIO0(Tch)

Key On Wakeup

16Bit Timer/
Counter(TC1)

8bit Timer/Counter{2ch}

UART(1ch)




TMP86FH47BUG Terminal Functions

pin port lfe} function active normal
1 |[vss to GND
2 XIN I x'tal
3 | XouT O (xtal
4 |TEST to VSS/VDD
5 VDD to 3.3v
6 P21(XTIN) (0] LEDR H
7 P22(XTOUT) (0] LED G H L
8 REST | reset
9 P20(STOP/INTS5) | Stop mode cancellation HIGH eddge L
10 [POO(INTO) | ASO/DC protector LOW eddge H
11 | POL(TC4) (0] P direct output H L
12 | PO2(RXD) I | RXD(prom) L H
13 | PO3(TXD) O | TXD(prom) L H
14 [P0O4(SO) O |analog sw data H L
15 ([PO5(SI) O |analog sw strobe H L
16 [PO6(SCK) O |analog sw clock H L
17 [PO7(INT4) O | sourece direct output H L
18 (P17 | P direct input L L
19 (P16 | source direct input L L
20 |P15(INT3) O | ac power relay H L
21 |P14(PPG) O |volume up H L
22 | P13(DVO) O |volume down H L
23 | P12(INT2) | remocon input L H
24 | P11(INT1) | Power off (power failure) H L
25 |P10(TC3) O |timer reset L H
26 | P30(AINO) | Model switch AD AD
27 | P31(AIN1) | sp output A/B AD AD
28 | P32(AIN2) I |NC AD AD
29 | P33(AIN3) | function A eddge/AD
30 | P34(AIN4/STOP2) O | head phone/muting H L
31 | P35(AIN5/STOP3) O |[spoutputA H L
32 | P36(AIN6/STOP4) O |[spoutputB H L
33 | P37(AIN7/STOP5) I | THERMAL protector LOW eddge H
34 ([VAREF to VDD
35 |AVDD to VDD
36 |AVSS to VSS
37 | P40 O | phono LED/relay drive H L
38 |P41 O |cd LED/relay drive H L
39 |P42 O [tuner LED H L
40 | P43 O AUX LED H L
41 | P44 O NETWORK LED H L
42 P45 O |Recorder LED H L
43 | P46 | SIG. Timer L H
44 | P47 | NC L H
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POWER AMP

POWER AMP PCB ASS'Y

NOTE:The symbols in the column Remarks indicate the following destinations.
E3: U.S.A. & Canada model E2: Europe model E1C : China model E1 : Asia model JP : PMA1500RE(Japan model)
BK: Black model  SP : Premium Silver model

[ REF No. [ Part No. | Part Name [ Remarks [ [ Qty[New][ Ver
SEMICONDUCTORS GROUP
D0101-0106 00MHD20002711 [1A3 1A/200V 6
D0107 20105001130AS |1SS133(HOMI) 1
D0519 00D3939645009 [SML1216W(D) 1
D0520 00D2760794900 [KDS160-RTK/P 1
D0601 20105001130AS |1SS133(HOMI) 1
D0801-0804 20105001130AS |1SS133(HOMI) 4
D0805-0808 00D2760683930 |UDZS5.1B-TE17 +C 4
D0809,0810 20105001130AS |1SS133(HOMI) 2
D0811,0812 00D2760683927 |UDZS7.5B-TE17 +C 2
D0813-0816 20105001130AS |1SS133(HOMI) 4
D0817,0818 00D2760683943 |UDZS3.6B-TE17 2
D0819,0820 20105001130AS |1SS133(HOMI) 2
D0821,0822 00D2760853906 |UDZS2.0B-TE17 2
D0901 20105001130AS |1SS133(HOMI) 1
D0904-0908 20105001130AS |1SS133(HOMI) 5
D0910 00MHE20030290 [D30XBN20 SBD BRIDGE 1
D0911-0914 00D2760798922 |UDZS18B-TE17 4
Q0504 00MHX300012A0 |2SC4081 (Q R) 25C4116 (Y GR) 1
Q0505 00D2690184907 |KRA102S-RTK/P (10K-10K) 1
Q0801,0802 22255001850AS |2SK2145GR/BL(5LDMH.F) 2
Q0803-0812 00D2730479909 [2N5551S-RTK/P 10
Q0813-0816 21105001420AS |KTA1360-Y-U/PH 4
Q0817,0818 21305001420AS |KTC3423-Y-U/PH 2
Q0821,0822 00D2730461001 [KTC4370A-Y-U/P 2
Q0823,0824 00D2710302009 [KTA1659A-Y-U/P 2
Q0829,0830 00D2730479909 |2N5551S-RTK/P 2
Q0831-0834 00D2710318909 [2N5401S-RTK/P 4
Q0901 00D2730461001 |KTC4370A-Y-U/P 1
Q0902 00D2710302009 [KTA1659A-Y-U/P 1
Q0903,0904 00D2750094908 |2SK209-GR +C 2
Q0905-0907 00D2730479909 [2N5551S-RTK/P 3
U0501 00D2623602003 [GP1UE271XKVF 1
RESISTOR GROUP
R0201,0202 nsp RD14B2E334JT(5) 2
R0203,0204 nsp RD14B2E105JT(5) 2
R0205,0206 nsp RD14B2E334JT(5) 2
R0209-0214 nsp RD14B2E221JT(5) 6
R0528 nsp RM73B--183JT +1608 1
R0529,0530 nsp RM73B--473JT +1608 2
R0601,0602 0002412469949 [RD14B2E472JT(AMRS) 2
R0603,0604 00D2412469923 [RD14B2E392JT(AMRS) 2
R0605,0606 0002412471966 [RD14B2E393JT(AMRS) 2
R0607,0608 00D2412469981 [RD14B2E682JT(AMRS) 2
R0609 nsp RD14B2E223JT(5) 1
R0610 nsp RD14B2E473JT(5) 1
R0611 675010007006D [V2720V30FB503MC 1
R0801,0802 00D2412475904 [RD14B2E105JT(AMRS) 2
R0803,0804 00D2412465943 [RD14B2E101JT(AMRS) 2
R0805,0806 00D2412470941 [RD14B2E123JT(AMRS) 2
R0807,0808 00D2412469949 [RD14B2E472JT(AMRS) 2
R0809,0810 00D2412470941 [RD14B2E123JT(AMRS) 2
R0811,0812 00D2412469949 [RD14B2E472JT(AMRS) 2
R0813,0814 00D2412468924 |RD14B2E152JT(AMRS) 2
R0815,0816 00D2412467909 |RD14B2E471JT(AMRS) 2
R0817,0818 00D2412475904 |RD14B2E105JT(AMRS) 2
R0819,0820 00D2412472907 |RD14B2E563JT(AMRS) 2
R0821,0822 00D2412472923 |RD14B2E683JT(AMRS) 2
R0823,0824 00D2412465985 |RD14B2E151JT(AMRS) 2
R0827,0828 00D2442694975 [RS14B3A331INBST AMRA 2
R0829,0830 00D2442694920 |RS14B3A101JNBST AMRA 2
R0831,0832 00D2412468908 |RD14B2E122JT(AMRS) 2
R0833,0834 00D2442694975 |RS14B3A331IJNBST AMRA 2
R0835,0836 00D2442694920 [RS14B3A101IJNBST AMRA 2
R0837,0838 00D2442696931 [RS14B3A123JNBST AMRA 2
R0839,0840 00D2442694917 [RS14B3A820IJNBST AMRA 2
R0841,0842 00D2442694946 [RS14B3A151INBST AMRA 2
R0843,0844 00D2412467909 [RD14B2E471JT(AMRS) 2
R0845,0846 00D2442694946 [RS14B3A151INBST AMRA 2
R0847,0848 00D2412475904 [RD14B2E105JT(AMRS) 2
R0849,0850 00D2412469907 [RD14B2E332JT(AMRS) 2
R0851-0856 00D2442694988 |RS14B3A391JNBST AMRA 6
R0857-0860 00D2442694920 [RS14B3A101JNBST AMRA 4
R0861,0862 00D2442694988 |RS14B3A391JNBST AMRA 2
R0863-0866 00MGO005001056 |0.1 OHMS +-5% 5W PBR58 4
R0867,0868 00D2412471966 [RD14B2E393JT(AMRS) 2
R0869,0870 0002412468966 [RD14B2E222JT(AMRS) 2
R0871,0872 nsp RD14B2E103JT(5) 2
R0873,0874 00D2412470967 [RD14B2E153JT(AMRS) 2
R0875,0876 nsp RD14B2E103JT(5) 2
R0879,0880 nsp RD14B2E333JT(5) 2
R0881,0882 nsp RD14B2E103JT(5) 2
R0883,0884 00D2442693947 [RS14B3A220JNBST AMRA 2
R0885,0886 nsp RM73B--473JT +1608 2
R0887,0888 nsp RM73B--224JT +1608 2
R0889,0890 nsp RD14B2E153JT(5) 2
R0891-0894 00D2442692977 [RS14B3A4R7IJNBST AMRA 4
R0895,0896 00MRA04720781 [4.7KOHM NVZ6TLTA B472 2
R0901,0902 00D2412467983 |RD14B2E102JT(AMRS) 2
R0905 nsp RD14B2E472JT(5) 1
R0906 nsp RD14B2E473JT(5) 1
R0907 nsp RD14B2E472JT(5) 1
R0908 nsp RD14B2E473JT(5) 1
R0909 nsp RD14B2E472JT(5) 1
R0910 nsp RD14B2E473JT(5) 1




POWER AMP

| REF No. | Part No. | Part Name | Remarks | [ Oty [New] Ver
| R0981-0984 | 00D2442051929 [RS14B3A821INBST(S) | | | 4] |
CAPACIITORS GROUP
C0101 nsp CE04W1HR47MT(KR3) 1
C0102 00D2544703706 |CE04W1H101MC(RFS#A) 1
! C0103 00D2538029726 |CK45F2EAC332MC(KX) 1
C0104 nsp CQ93M2A104JT(PEF) 1
C0105 00D2544576713 |CE04W1V102MC(RA3) 1
€0201,0202 133050074500S _[CQ93M2E101J(LP) E2, EIC 2
C0205,0206 133050074500S _[CQ93M2E101J(LP) E2, EIC 2
C0501 133050076599S _[CQ93M2E103J(LP) 1
C0602 133050076599S _[CQ93M2E103J(LP) 1
C0606 00D2544702956 |CE04W1H100MT(RFS#A) 1
€0801,0802 133050074500S _[CQ93M2E101J(LP) 2
€0803,0804 00D2544702956 |CE04W1H100MT(RFS#A) 2
C0805,0806 133050076513S _[CQ93M2E222](LP) 2
€0807,0808 133050074500S _[CQ93M2E101J(LP) 2
C0809-0812 00D2544774719 |CE04W1E221MF(RFS#A) 4
C0813,0814 133050078489S _[CQ93P2D470K(FAS) 2
C0815-0818 00D2544705746 |CE04W2A221MC(RFS#A) 4
€0819,0820 nsp CQI93M2A272JT(PEF) 2
€0821,0822 133050074500S _[CQ93M2E101J(LP) 2
C0823,0824 nsp CQ93M2A272JT(PEF) 2
C0825,0826 133050078465S _|CQ93P2D330K(FAS) 2
C0827-0830 00D2544703719 |CE04W1H221MC(RFS#A) 4
€0831,0832 133050074555S _[CQ93M2E271J(LP) 2
C0835-0840 133050076599S _[CQ93M2E103J(LP) 6
€0841,0842 00MOF55104586 |0.1UF 100V +- 5% FNS100VDC-104J-FL 2
€0843,0844 133050076599S _[CQ93M2E103J(LP) 2
C0905,0906 00D2544703735 |CE04W1H471MC(RFS#A) 2
€0907,0908 00D2544703777 |CE04W1H470MC(RFS#A) 2
€0909,0910 13405022900AS _[8200uF/71V 2 *
C0911,0912 00MOF55224586 [0.22UF 100V.DC FNS SHINEI 2
C0917,0918 00MOF55224586 [0.22UF 100V.DC FNS SHINEI 2
OTHER PARTS GROUP
B0651 nsp 6P EH-SCN CORD 1
! F0101 00D2061096048 |FUSE(218)T3.15AL/250V. E2, EIC 1 Ver.2
! F0101 00D2061052008 |FUSE 8A JP 1
! F0108 00D2061052008 |FUSE 8A JP 1
! F0901,0902 00MFS20025201 | # T250MA/250V TR5 NO.19372(TP) 2
H1011,1012 nsp FUSE_CLIP(TAPE) E2, EIC 2
H1081,1082 nsp FUSE CLIP(TAPE) JP 2
JV992-999 nsp COMMON PLATE(30-3) 4
! K0101 641050009007D |AC OUTLET JP 1
K0203 643810028008S _[RCA PIN JACK 4P AU MSP-244V4-17 GILT LF 1
K0204 643810029001S _[RCA PIN JACK 2P AU MSP-242V3-12 GILT LF 1
K0981 643010073204S _[PHONE JACK BOARD(9P) 1
N0211 nsp CONNECTOR 2P _B3P-VH 1
N0221 nsp CONNECTOR 2P _B3P-VH 1
N0231 nsp CONNECTOR 2P _B3P-VH 1
N0241 nsp CONNECTOR 2P _B3P-VH 1
N0331 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1
N0341 nsp S3B-EH 1
NO351 nsp S3B-EH 1
N0360 nsp S3B-PH-K-S (LF)(SN) 1
NO371 nsp CONNECTOR 2P _B3P-VH 1
N0372 nsp B3B-PH-K-S (LF)(SN) 1
NO0381,0382 nsp CONNECTOR 2P _B3P-VH 2
NO511 nsp B5B-PH-K-S (LF)(SN) 1
N0521 nsp B5B-EH-TS (LF)(SN) 5P RADIAL TAPING 1
N0522 nsp S5B-EH 1
N0532 nsp B5B-PH-K-S (LF)(SN) 1
N0612 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1
N0621 nsp 13P PLUG(C125Z1) 1
N0622,0623 nsp 13P SOCKET(C12522) 2
N0631 nsp 13P PLUG(C125Z1) 1
N0641 nsp S6B-PH-K-S (LF)(SN) 1
N0651 nsp B6B-EH-TS (LF)(SN) 6P RADIAL TAPING JST 1
NO0801,0802 nsp 3P NH CONNECTOR BASE 2
N0805-0808 nsp M3 SCREW TERMINAL 4
N0822 nsp B8B-PH-K-S (LF)(SN) 1
N0831 nsp 17P PLUG(C125Z1) 1
N0832 nsp 17P SOCKET(C12522) 1
N0841 nsp 17P PLUG(C125Z1) 1
N0842 nsp 17P SOCKET(C12522) 1
N0912 nsp B9B-PH-K-S (LF)(SN) 1
N1011 nsp B10B-EH 1
! S0101 66105000300AS |POWER SWITCH (TV-5) 1
! S0102 00D2140241002 |RELAY DL1SU TV-8 1
S0601,0602 665010010005D [1P PUSH SWITCH(6-2) 2
S0603 00D2140127003 |RELAY(RY-12W) 1
S0801 00D2140195006 |RELAY FTR-F1 1
S0802,0803 00D2140127003 |RELAY(RY-12W) 2
! T0101 10101016700AD |STANDBY TRANS E2 E2, EIC 1
! T0101 10101016600AD [STANDBY TRANS JP JP 1
70602-0604 nsp M3 SCREW TERMINAL 3
Z0801,0802 nsp 1P SIN CON CORD 2
70901,0902 nsp HEAT SINK 2
70903,0904 nsp 3X8 CBS-B 2
70910 nsp HEAT SINK(PUG56) 1
20913,0914 252310006506S _[PRF18BB471QB5RB 2
70920 nsp SCREW 1
* nsp CHUKOH TAPE 33




INPUT UCOM

INPUT UCOM PCB ASS'Y

NOTE:The symbols in the column Remarks indicate the following destinations.
E3: U.S.A. & Canada model E2: Europe model E1C : China model E1 : Asia model JP : PMA1500RE(Japan model)
BK: Black model  SP : Premium Silver model

[ REF No. [ Part No. | Part Name [ Remarks [ [ Qty[New][ Ver

SEMICONDUCTORS GROUP

D0201-0204 20105001130AS [1SS133(HOMI)

D0303-0305 00MHD20002711 [1A3 1A/200V

D0308-0310 00MHD20002711 |1A3 1A/200V

! D0311,0312 00MHD20055101 |SHOTTKY 11EQS10 1A 100V

D0313-0315 00D2760794900 |KDS160-RTK/P

D0317,0318 00D2760794900 [KDS160-RTK/P

D0322 00D2760683943 [UDZS3.6B-TE17

D0323 00D2760683969 [UDZS12B-TE17 +C JP

D0401,0402 20105001130AS [1SS133(HOMI)

D0501-0512 00D2760794900 [KDS160-RTK/P

D0513-0518 00D3939658915 [SEL2915A-TP6

D0521 20105001130AS_|1SS133(HOMI)

D0522 00MHI20002210_|SIR-34ST3F
Q0301-0306 00D2690192902 |KRC102S-RTK/P (10K-10K)

Q0307 00D2690184907 |KRAI02S-RTK/P (10K-10K)
Q0308,0309 00D2690088906 |DTC114TKT96 +C

Q0310 00D2690184907 |KRA102S-RTK/P (10K-10K)
Q0311,0312 00D2690192902 |KRC102S-RTK/P (10K-10K)

Q0313 00D2690088906 |DTC114TKT96 +C

Q0314 00D2710260905_|2SA1036KT146(S/R) _+C

Q0315 00D2690088906 |DTC114TKT96 +C

Q0318 00D2740195901 | 2SD2114KT196 +C

Q0316 00D2690192902 |KRC102S-RTK/P (10K-10K) P

Q0317 00D2690066902 | DTC323TKT96 +C JP

Q0319 00MHX300012A0 |2SC4081 (Q R) 2SCA4116 (Y GR)
Q0320,0321 00D2690184907 |KRA102S-RTK/P (10K-10K)

Q0322 00D2690192902 |KRC102S-RTK/P (10K-10K)

Q0323 00MHX300012A0 |2SC4081 (Q R) 2SCA4116 (Y GR)

Q0324 00D2690192902 |KRC102S-RTK/P (10K-10K)

Q0325 00D2690184907 |KRA102S-RTK/P (10K-10K)
Q0326-0330__| OOMHX300012A0 |2SC4081 (Q R) 2SC4116 (Y GR)
Q0331-0334 00D2690184907 |KRA102S-RTK/P (10K-10K)

Q0335 00D2690088906_|DTC114TKT96 +C

Q0336 00D2690192902 |KRC102S-RTK/P (10K-10K)

Q0337 00D2690184907 |KRAI102S-RTK/P (10K-10K)

Q0338,0339 0002690192902 [KRC102S-RTK/P (10K-10K)

Q0401-0406 22255001850AS [2SK2145GR/BL(5LDMH.F)

Q0501-0503 0002690184907 [KRA102S-RTK/P (10K-10K)

U0201 00MHC10309030 |IC LC78212:CMOS LOGIC SANYO

U0203,0204 00D2631289900 [AZ4580MTR-E1

U0205,0206 23581005750AS |NJU7181RB1-TE1
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U0301 9R2481015100D |PMA1520AE/PMA1500RE ROM ASSY *
u0302 23581005850AS |LB1930MC

U0303 23181015150AS |NJM11100F1 *
u0304 00D2630801004 |NJM7812FA(S)

U0305 00D2630793002 |NJM7806FA(S)

u0401 00D2623555901 [SA5532ADR

U0502 00D3991126003 |GP1UE261XKVF

U701 00D2631289900 [AZ4580MTR-E1

RESISTOR GROUP

R0217,0218 00D2412473980 [RD14B2E334JT(AMRS) 2
R0219-0222 nsp RD14B2E334JT(5) 4
R0223,0224 00D2412466926 [RD14B2E221JT(AMRS) 2
R0225-0228 nsp RD14B2E221JT(5) 4
R0231,0232 nsp RD14B2E222JT(5) 2
R0233,0234 nsp RD14B2E105JT(5) 2
R0235,0236 nsp RM73B--222JT +1608 2
R0237,0238 nsp RM73B--104JT +1608 2
R0239 nsp RM73B--224JT +1608 1
R0241,0242 nsp RD14B2E222JT(5) 2
R0243,0244 nsp RD14B2E105JT(5) 2
R0245,0246 nsp RM73B--222JT +1608 2
R0247,0248 nsp RM73B--104JT +1608 2
R0249 nsp RM73B--224JT +1608 1
R0251,0252 nsp RD14B2E102JT(5) 2
R0253,0254 nsp RD14B2E105JT(5) 2
R0257,0258 00MGG05100160 | 10 OHM +- 5% 1/6W 2
R0260 nsp RM73B--103JT +1608 1
R0261 nsp RM73B--101JT +1608 1
R0262 nsp RM73B--221JT +1608 1
R0263 nsp RM73B--101JT +1608 1
R0264 nsp RM73B--221JT +1608 1
R0265 nsp RM73B--101JT +1608 1
R0266 nsp RM73B--221JT +1608 1
R0301,0302 nsp RM73B--821JT +1608 2
R0305 nsp RM73B--102JT +1608 1
R0306 nsp RM73B--104JT +1608 1
R0307 nsp RM73B--472JT (1608) +1608 1
R0308 nsp RM73B--331JT (1608) +1608 1
R0309 nsp RM73B--102JT +1608 1
R0310,0311 nsp RM73B--104JT +1608 2
R0312 nsp RM73B--105JT +1608 1
R0313 nsp RM73B--102JT +1608 1
R0314 nsp RM73B--104JT +1608 1
R0315-0317 nsp RM73B--102JT +1608 3
R0319 nsp RM73B--104JT +1608 1
R0320 nsp RM73B--102JT +1608 1
R0321 nsp RM73B--104JT +1608 1
R0322 nsp RM73B--102JT +1608 1
R0323 nsp RM73B--104JT +1608 1
R0324,0325 nsp RM73B--102JT +1608 2
R0326 nsp RM73B--223JT +1608 1
R0327-0329 nsp RM73B--102JT +1608 3
R0330 nsp RM73B--223JT +1608 1




INPUT UCOM

REF No. Part No. Part Name Remarks Q'ty [ New | Ver
R0332 nsp RM73B--472JT (1608) +1608 1
R0333,0334 nsp RM73B--103JT +1608 2
R0335 nsp RM73B--472JT (1608) +1608 1
R0336 nsp RM73B--102JT +1608 1
R0337,0338 nsp RM73B--104JT +1608 2
R0339 nsp RM73B--472JT (1608) +1608 1
R0340 nsp RM73B--223JT +1608 1
R0341-0345 nsp RM73B--102JT +1608 5
R0346 nsp RM73B--472JT (1608) +1608 1
R0347 nsp RM73B--103JT +1608 1
R0348 nsp RM73B--102JT +1608 1
R0349 nsp RM73B--224JT +1608 1
R0350 nsp RM73B--103JT +1608 1
R0351 nsp RM73B--102JT +1608 1
R0352 nsp RM73B--473JT +1608 1
R0354 nsp RM73B--103JT +1608 1
R0357 nsp RM73B--102JT +1608 1
R0358 nsp RM73B--222JT +1608 1
R0359 nsp RM73B--101JT +1608 1
R0360 nsp RM73B--121JT +1608 1
R0361 nsp RM73B--183JT +1608 1
R0362 nsp RM73B--0ROKT +1608 1
R0363 nsp RM73B--222JT +1608 1
R0365,0366 nsp RM73B--473JT +1608 2
R0367 nsp RM73B--102JT +1608 JP 1
R0368 nsp RM73B--102JT +1608 1
R0369 nsp RM73B--473JT +1608 1
R0370 nsp RM73B--223JT +1608 1
R0O371 nsp RM73B--102JT +1608 1
R0372 nsp RM73B--223JT +1608 1
R0373,0374 nsp RM73B--102JT +1608 2
R0375 nsp RM73B--472JT (1608) +1608 1
R0376 nsp RM73B--222JT +1608 1
R0377 nsp RM73B--0ROKT +1608 E2, EIC 1
R0378 nsp RM73B--0ROKT +1608 1
R0379 nsp RM73B--223JT +1608 1
R0380,0381 nsp RM73B--224JT +1608 2
R0382 nsp RM73B--823JT +1608 1
R0383 nsp RM73B--223JT +1608 1
R0384 nsp RM73B--473JT +1608 1
R0401-0404 nsp RD14B2E471JT(5) E2, EIC 4
R0405,0406 nsp RD14B2E101JT(5) 2
R0407,0408 nsp RD14B2E473JT(5) 2
R0409,0410 nsp RD14B2E100JT(5) 2
R0411-0414 nsp RD14B2E332JT(5) 4
R0415,0416 nsp RD14B2E221JT(5) 2
R0417,0418 nsp RD14B2E222JT(5) 2
R0419,0420 nsp RD14B2E820JT(5) 2
R0421,0422 nsp RD14B2E105JT(5) 2
R0423,0424 nsp RD14B2E473JT(5) 2
R0425,0426 nsp RD14B2E392JT(5) 2
R0427,0428 nsp RD14B2E220JT(5) 2
R0429,0430 nsp RD14B2E154JT(5) 2
R0431,0432 nsp RD14B2E474JT(5) 2
R0433,0434 nsp RD14B2E6R8JT(5) 2
R0435,0436 nsp RD14B2E221JT(5) 2
R0437,0438 nsp RD14B2E223JT(5) 2
R0439 nsp RD14B2E821JT(5) 1
R0441,0442 00MGG05100160 |10 OHM +- 5% 1/6W 2
R0443-0446 nsp RM73B--OROKT +1608 4
R0501,0502 nsp RM73B--124JT +1608 2
R0503-0505 nsp RM73B--103JT +1608 3
R0506 nsp RM73B--472JT (1608) +1608 1
R0507 nsp RM73B--152JT +1608 1
R0508 nsp RM73B--392JT +1608 1
R0509,0510 nsp RM73B--152JT +1608 2
R0511 nsp RM73B--222JT +1608 1
R0512 nsp RM73B--152JT +1608 1
R0513 nsp RM73B--101JT +1608 1
R0514 nsp RM73B--122JT +1608 1
R0O515 nsp RM73B--101JT +1608 1
R0516,0517 nsp RM73B--222JT +1608 2
R0518,0519 nsp RM73B--182JT +1608 2
R0522,0523 nsp RM73B--151JT +1608 2
R0524 nsp RM73B--472JT (1608) +1608 1
R0525 nsp RM73B--103JT +1608 1
R0526,0527 nsp RD14B2E101JT(5) 2
R0621,0622 nsp RD14B2E104JT(5) 2
R0623,0624 nsp RD14B2E471JT(5) 2
R0625,0626 nsp RD14B2E123JT(5) 2
R0703,0704 nsp RD14B2E154JT(5) 2
R0705,0706 nsp RD14B2E471JT(5) 2
R0707,0708 nsp RD14B2E330JT(5) 2
R0709,0710 nsp RD14B2E474JT(5) 2
R0711,0712 nsp RD14B2E821JT(5) 2
R0713,0714 nsp RD14B2E101JT(5) 2
R0715-0718 nsp RD14B2E153JT(5) 4
R0719-0722 nsp RD14B2E182JT(5) 4
R0723,0724 nsp RD14B2E332JT(5) 2
R0725,0726 nsp RD14B2E471JT(5) 2
R0727,0728 nsp RD14B2E223JT(5) 2
R0729,0730 nsp RD14B2E471JT(5) 2
R0731,0732 00D2442051974 |RS14B3A102JNBST(S) 2
R0733 00D2110798103 |V14V20FW104K 1
R0734 00D2110834012 [V14V20FA103K 1
R0735 00D2110834009 [V14V20FA303K 1
CAPACIITORS GROUP
C0209-0214 133050074500S _|CQ9I3M2E101J(LP) E2, E1C 6
C0215-0218 00D2544702956 |CE04W1H100MT(RFS#A) 4
C0219 nsp CE04W1H100MT(RA3) 1
C0220 133050075527S  |CQ93M2E102J(LP) 1
C0221,0222 nsp CE04W1H2R2MT(RA3) 2




INPUT UCOM

REF No. Part No. Part Name Remarks Q'ty [ New | Ver
C0223,0224 133050074500S  |CQ93M2E101J(LP) 2
C0225,0226 nsp CE04W1H100MT(RA3) 2

C0227 133050078403S  |CQ93P2D100K(FAS) 1
C0228,0229 nsp CE04W1H100MT(RA3) 2
C0230-0232 nsp CEO04W1H2R2MT(RA3) 3
C0233,0234 133050074500S |CQ93M2E101J(LP) 2
C0235,0236 nsp CE04W1H100MT(RA3) 2

C0237 133050078403S _|CQ93P2D100K(FAS) 1
C0238,0239 nsp CE04W1H100MT(RA3) 2

C0240 nsp CE04W1H2R2MT(RA3) 1
C0241-0244 nsp CE04W1H100MT(RA3) 4
C0245,0246 nsp CE04W1C101MT(RA3) 2
C0251-0253 nsp CQ93M2A221JT(PEF) 3

C0301 nsp CE04W1H100MT(RA3) 1

C0302 nsp CQ93P2A103JT(PPF) 1

C0303 nsp CE04W1H100MT(RA3) 1

C0304 nsp CQ93P2A103JT(PPF) 1

C0305 nsp CE04W1H100MT(RA3) 1

C0306 nsp CQ93P2A103JT(PPF) 1

C0307 nsp CE04W1HR22MT(KR3) 1

C0308 nsp CF93A1H105JT(JL) 1

C0309 nsp CE04W1C332MC(RA3) 1

C0310 nsp CQ93P2A103JT(PPF) 1

C0311 nsp CE04W1H101IMT(RA3) 1

C0312 nsp CE04W1H100MT(RA3) 1

C0313 nsp CE04W1H2R2MT(RA3) 1

C0314 nsp CE04W1H101MT(RA3) 1
C0315-0317 nsp CE04W1H100MT(RA3) 3

C0318 00D2544774706 |CEO04W1E101MF(RFS#A) 1

C0319 133050076599S |CQI3M2E103J(LP) 1

C0320 nsp CE04W1C101MT(RA3) 1
C0321-0323 133050076599S |CQI3M2E103J(LP) 3

C0324 00D2544576700 [CE04W1V222MC(RA3) 1
C0325,0326 133050076599S |CQ9I3M2E103J(LP) 2
C0327,0328 nsp CQ93P2A103JT(PPF) 2

C0330 nsp CQ93P2A103JT(PPF) 1

C0331 nsp CE04W1HR22MT(KR3) 1

C0332 nsp CE04W1C331MT(RA3) 1

C0333 nsp CE04W1HO010MT(RA3) 1

C0334 nsp CEQ4W1H330MT(RA3) 1

C0335 nsp CQ93M2A104JT(PEF) 1

C0336 nsp CQ93P2A103JT(PPF) 1

C0340 nsp CE04W1H100MT(RA3) 1

C0341 nsp CQ93M2A104JT(PEF) 1

C0342 nsp CQ93P2A103JT(PPF) 1

C0343 nsp CC73CH1H101JT _ +1608 1
C0405,0406 133050078489S  |CQ93P2D470K(FAS) E2, EIC 2
C0407,0408 133050074524S |CQ93M2E151J(LP) 2
C0409,0410 133050075527S  |CQ93M2E102J(LP) 2
C0411,0412 133050074500S |CQ93M2E101J(LP) E2 E1C 2
C0413,0414 133050076537S |CQ93M2E332J(LP) 2
C0415,0416 nsp CE04W1H101IMT(RA3) 2
C0417,0418 nsp CQ93P2A683JT(PPF) 2
C€0419,0420 133050075534S |CQI3M2E122)(LP) 2
C0421,0422 nsp CQ93M2A183JT(PEF) 2
C0423,0424 nsp CE04W1H100MT(RA3) 2
C0425,0426 133050075527S |CQ93M2E102J(LP) 2
C0427,0428 00D2544774706 |CEO04W1E101MF(RFS#A) 2

C0429 nsp CE04W1H101MT(RA3) 1
C0431,0432 00D2544702956 [CE04W1H100MT(RFS#A) 2
C0502,0503 133050076599S  |CQ93M2E103J(LP) 2

C0504 nsp CE04W1H010MT(RA3) 1
C0621,0622 nsp CE04W1H470MT(RA3) 2

C0623 133050076599S |CQI3M2E103J(LP) 1
C0701,0702 nsp CE04W1H4R7MT(RA3) 2
C0707,0708 133050074500S |CQ93M2E101J(LP) 2
C0709,0710 nsp CEO04W1E101MT(R2A) 2
C0711,0712 nsp CE04W1H100MT(RA3) 2
C0713,0714 nsp CF93A1H333JT (JL) 2
C0715,0716 nsp CE04W1HR22MT(KR3) 2
C0717,0718 nsp CE04W1HR10MT(KR3) 2
C0719,0720 nsp CE04W1HR47MT(KR3) 2
C0721,0722 133050076537S |CQ93M2E332J(LP) 2
C0723,0724 133050074500S |CQ93M2E101J(LP) 2

OTHER PARTS GROUP

B1011 nsp 10P 160mm EH-SCN 1

! F0301,0302 00MFS20050201 |T500MA/250V TR5 NO.19372(TP) 2
K0201,0202 643810028008S |RCA PIN JACK 4P AU MSP-244V4-17 GILT LF 2
K0501 00D2048729008 |2P MINI JACK 1
K0601 643810028008S |RCA PIN JACK 4P AU MSP-244V4-17 GILT LF 1
L0401-0404 nsp FTZ CHOKE COIL E2, EIC 4
NO0312 nsp B3B-PH-K-S (LF)(SN) 1
N0322 nsp B3B-PH-K-S (LF)(SN) 1
N0332 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1
N0342 nsp B3B-EH-TS (LF)(SN) 3P RADIAL TAPING 1
N0352 nsp S3B-EH 1
NO361 nsp B3B-PH-K-S (LF)(SN) 1
NO0371 nsp B3B-PH-K-S (LF)(SN) 1
N0512 nsp B5B-PH-K-S (LF)(SN) 1
NO531 nsp B5B-PH-K-S (LF)(SN) 1
NO611 nsp BASE POST 6P S6B-EH NICHIATSU 1
N0642 nsp S6B-PH-K-S (LF)(SN) 1
NO691 nsp B6B-PH-K-S (LF)(SN) 1
NO0821 nsp B8B-PH-K-S (LF)(SN) 1
N0911 nsp B9B-PH-K-S (LF)(SN) 1
N1101 nsp B11B-PH-K-S (LF)(SN) 1
N1110 nsp B11B-PH-K-S (LF)(SN) 1
N1511 nsp B15B-PH-K-S (LF)(SN) 1
N1512 nsp S15B-PH-K-S (LF)(SN) 1
S0201,0202 00D2140127003 [RELAY(RY-12W) 2
S0401 665010011008D 1P PUSH SWITCH(4-2) 1
S0503 00D2120407002 [ROTALY SW.(SRRM-12) 1




INPUT UCOM

REF No. Part No. Part Name Remarks Q'ty [ New | Ver
X0301 00MFQO08004061 [CSTS MG 8MHZ TAPING(15PF) 1
Z0501 nsp SHIELD CASE FLASHER SR7005 A332 1
* nsp CHUKOH TAPE 33




EXPLODED

EXPLODED
NOTE:The symbols in the column Remarks indicate the following destinations.
E3: U.S.A. & Canada model E2: Europe model E1C: China model E1 : Asia model JP :Japan model
BK: Black model  SP : Premium Silver model
REF No. Part No. Part Name Remarks Q'ty [ New | Ver
1 nsp POWER AMP UNIT E2/E1C E2, EIC 8U-110144A 1 *
1 nsp POWER AMP UNIT E2/E1C JP 8U-110144B 1 *
1-1 — POWER AMP UNIT 8U-110144-1 1
1-2 — AC UNIT 8U-110144-2 1
1-3 — POWER SW.UNIT 8U-110144-3 1
1-4 — FRONT SW UNIT 8U-110144-4 1
1-5 — VOLUME UNIT 8U-110144-5 1
1-6 — POWER LED UNIT 8U-110144-6 1
1-7 — VOL SUB UNIT 1 8U-110144-7 1
1-8 — VOL SUB UNIT 2 8U-110144-8 1
1-9 — H/P UNIT 8U-110144-9 1
1-10 — REC INPUT UNIT 8U-110144-10 2
2 nsp INPUT UCOM UNIT E2/E1C E2, EIC 8U-110145A 1 *
2 nsp INPUT UCOM UNIT JP JP 8U-110145B 1 *
2-1 — U-COM UNIT 8U-110145-1 1
2-2 — INPUT UNIT 8U-110145-2 1
2-3 — FUNCTION SW UNIT 8U-110145-3 1
2-4 — REMOTE IN/OUT UNIT 8U-110145-4 1
2-5 — TONE UNIT 8U-110145-5 1
2-6 — PRE OUT UNIT 8U-110145-6 1
3 nsp MAIN CHASSIS 1
4 nsp CENTER CHASSIS (L) 1
5 nsp EDGING GEE62FAC 40 2
6 nsp EDGING GEE62FAC 140 2
7 nsp CENTER BRACKET (R) 1
8 nsp SUPPORT BRACKET 2
9 nsp TRANS PLATE 1
10 nsp TRANS PLATE 1
11 00D1462088122 [FOOT ASSY 4
12 nsp P.W.B.HOLDER (H=10) 7
13 nsp P.W.B.HOLDER 1
14 nsp BACK PANEL(PMA1520AE) E2 1
14 nsp BACK PANEL(PMA1520AEE1C) E1C 1
14 nsp BACK PANEL(PMA1500RE) JP 1
16 64601003201AD _|8P TERMINAL ASSY 1 *
17 nsp P.W.B.HOLDER (H=12) 1
! 18 00D2033996008 [AC INLET (2P) 1
20 nsp PLATE (M) 1
22 00D1431228007 [LENS SP 1
22 00D1431228010 |LENS BK 1
23 412510054008D |PUSH KNOB SP 2
23 412510054015D [PUSH KNOB BK 2
24 nsp PLATE(F) 1
25 nsp POWER RADIATOR 2
29 nsp P.W.B BRACKET(A) 4
31 nsp PLATE(RD) 2
33 nsp RADIATOR BRACKET 2
! 37 10101019800AD [POWER TRANS E2 E2, EIC 1 *
! 37 10101019900AD |POWER TRANS JP JP 1 *
! 37 10101019800AD [POWER TRANS E2 E2, EIC 1 *
! 37 10101019900AD |POWER TRANS JP JP 1 *
38 nsp TRANS LABEL(E) 2
39 00D1139303130 [POWER KNOB ASSY SP 1
39 41101025500AD |POWER KNOB ASSY BK 1
41 00D1120969004 [KNOB(F) ASSY SP 1
41 00D1120969017 [KNOB(F) ASSY BK 1
42 00D1120796125 [KNOB(MARU) ASSY SP 3
42 00D1120796138 |KNOB MARU ASSY BK 3
43 nsp RUBBER SHEET 3 *
44 403310040021D [TOP COVER SP SP 1 *
44 403310040038D _|TOP COVER BK BK 1 *
45 nsp SPACER 2 *
46 nsp RUBBER SHEET 3 *
48 nsp CU PLATE 2
51 nsp SHIELD PLATE 1
58 nsp FERRITE CORE GTFC-25-15-12 E2, EIC 1
61 40231032911AD |FRONT PANEL PMA1520AEBK BKE2 1 * | Ver.5
61 40231032912AD |FRONT PANEL PMA1520AESP SPE2 1 * |Ver.5
61 40231032913AD _|FRONT PANEL PMA1520AEE1C SPE1C 1 *
61 40231032910AD |FRONT PANEL PMA1500RE JP 1 *
62 432010020004D |HIMELON SHEET 2
63 44351007420AD _|KNOB GUIDE (L) SP 1 *
63 44351007421AD_|KNOB GUIDE (L)BK BK 1 * |Ver.2
64 44351007320AD _|KNOB GUIDE (R) SP 1 * |Ver.2
64 44351007321AD_|KNOB GUIDE (R)BK BK 1 * |Ver.2
65 00D1430991115 |LENS 1
66 0001031817106 [SPACER(L) 1
67 00D1430874229 |REMOCON WINDOW 1
68 45151013700AD _|RC WINDOW SPACER T1 SPACER T=1.0 1
69 45151013800AD |RC WINDOW SPACER T2 SPACER T=2.0 1
70 00D1431231007 [FILTER 1
71 42141002500AD |DENON BADGE 1
72 O0RD4737500044 |3X8 CBTS (P)-B 10
73 00D1120780160 [KNOB(M) ASSY SP 1 *
73 0001120780173 [KNOB(M) ASSY BK 1 *
* nsp INSULATING SHEET 4
* nsp RUBBER SHEET 1
* nsp WASHER 4
* nsp Terminal PHONO 1
* nsp CORD HOLDER (L50) 1
* nsp CORD HOLDER (L76) 4
* nsp UL TUBE (14.3) BK 2
* nsp UL TUBE (12.7) BK 1
* 13305022340AS [FNS100VDC-222J-TP E2, EIC 1
* 13305022340AS _[FNS100VDC-222J-TP E2, E1C 1




EXPLODED

REF No.

Part No.

Part Name

[ Remarks

*

13305022340AS [FNS100VDC-222J-TP

[E2, EIC

[ Q'ty [New] Ver |
[ 1] I ]




EXPLODED

REF No. Part No. Part Name Remarks Q'ty [ New | Ver

* 13305022340AS _|FNS100VDC-222]-TP E2, EIC 1

* 00MOF55102581 [1000PF 100V FNS E2, EIC 1

* 00MOF55102581 [1000PF 100V FNS E2, EIC 1

* 00D2730445001 |2SC4495 1

* 00D2730445001 [2SC4495 1

* 22205002200AS | TK30J25D 1 *

* 22205002200AS _[TK30J25D 1 *

* 22205002200AS | TK30J25D 1 *

* 22205002200AS _[TK30J25D 1 *
SCREW

101 nsp 3X16 CPTS(B) SW W 2

102 nsp 4X40 CBS 4

103 nsp 3X20 CBTS (P)-Z 1

104 nsp 3X6 CPS (SW.W) ZNP 4

105 nsp 4X8 CBTS(B)-N-3P SP 4

105 nsp 4X8 CBTS(B)-B-3P BK 4

* nsp FIXING SCREW 00D4770064107 11

* nsp B.H.TAPPED EJ330106 00M51280310U0 27

* nsp 3X8 CBTS (S)-B O0RD4737002021 58

* nsp 4X10 CBTS (S)-B O0RD4737007013 6

* nsp 4X6 CBTS (S)-B O0RD4737026007 8

* nsp 3X8 CBTS (P)-B O0RD4737500044 18

* nsp 2.6X6 CFTS(P)-B O0RD4737520008 4

* nsp EARTH SCREW ORD4770276005 1
WIRES

* nsp 3P VH CON.CORD 1

* nsp 3P VH-VH CON CORD 1

* nsp 5P 500mm PH - PH 1

* nsp 9P 300mm PH - PH 1

* nsp 8P 250mm PH - PH 1

* nsp 15P 150mm PH - PH 1

* nsp 11P 150mm PH-PH UL1430 AWG26 1

* nsp 5P PH CONN.CORD 1

* nsp 3P 125mm PH-PH UL1430 AWG26 1

* nsp 3P 400mm PH-PH UL2791 AWG28 SHIELD 1

* nsp 6P 400mm PH - PH 1

* nsp 3P EH-EH CON. CORD 1

* nsp 6P EH-EH CON.CORD 1

* nsp 3P EH-EH CON.CORD 1

* nsp 3P EH-EH CON.CORD 1

* nsp 5P EH-EH CON.CORD 1

* nsp 1P CONTACT ASS 1

* nsp 1P CONTACT ASS 1
TAPE

153 | 00D1250092003 [TOP COVER BEND ASSY BUTYL TAPE(W=50) 310mm | | [ 1] |

153 | 00D1250096009 |TOP COVER BEND ASSY NITOFLON TAPE(W50) 310mm | | | 1] |




PACKING

PACKING
NOTE:The symbols in the column Remarks indicate the following destinations.
E3: U.S.A. & Canada model E2: Europe model E1C : China model E1 : Asia model JP :Japan model
BK: Black model  SP : Premium Silver model
REF No. Part No. Part Name Remarks Q'ty [ New | Ver
1 nsp ENVELOPE 1
3 35201025310AD |INST.MANUAL(CD-ROM. E2) E2 1 * 4
3 35201028710AD _|INST.MANUAL(CD-ROM. E1C) E1C 1 * 4
3 54111107320AD _|INST.MANUAL(JP) JP 1 * 4
3 54111107400AD |GETTING STARTED (E2) E2 1 * 2
3 54111107200AD |GETTING STARTED (E1C) E1C 1 * 2
3 54111105000AD |GETTING STARTED (JP) JP 1 * 2
4 nsp SERVICE STATION LIST JP 1
4 nsp SAFETY INSTRUCTIONS (E2) E2 1
5 nsp BATTERY (R03X2) EASTPOWER 1
6 30701015500AD |RC-1186 1 *
1 nsp ENVELOPE E2 1
! 2 00MZC01803080 [2P AC CORD 10A 250V CLASS2 E2 1
! 2 00D2062249001 [AC CORD (E1C) E1C 1
! 2 611050028007S _|AC CORD 2P(JP) JP 1
7 nsp CABINET SHEET 1
8-1,8-2 53361020510AD |CUSHION ASSY 1 * 3
9 53121035821AD |CARTON CASE(PMA1520AE) E2, E1IC 1 * 3
9 53121035820AD |CARTON CASE(PMA1500RE) JP 1 * 3
10 nsp CONT.LABEL BASE(D&M) 1
11 nsp COLOR LABEL SPE2, E1C, JP 2
12 53721003600AD [CARTON SUPPORT 2 * 3






